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FTVM130 : Cinematic Storytelling Pathways

General Information

Author:

Course Code (CBO01) :
Course Title (CB02) :
Department:
Proposal Start:

TOP Code (CB03) :
CIP Code:

SAM Code (CB09) :

Distance Education Approved:

Will this course be taught asynchronously?:

Course Control Number (CB0O) :
Curriculum Committee Approval Date:
Board of Trustees Approval Date:

Last Cyclical Review Date:

Course Description and Course Note:

Justification:

Academic Career:

Academic Senate Discipline

Primary Discipline:

Alternate Discipline:

Alternate Discipline:

¢ Geraldine Ulrey

FTVM130

Cinematic Storytelling Pathways

FTVM

Fall 2024

(0604.20) Television (including combined TV/film/video)*
(09.0701) Radio and Television.

Clearly Occupational

No

No

CCC000640662

09/27/2023
11/21/2023
09/27/2023

FTVM 130 is an introductory course covering both the critical appreciation of cinema and the basic
techniques of digital filmmaking, while emphasizing students' personal and creative expression.
This course also introduces students to the career pathways to film and television including the
roles and responsibilities of the departments of a production crew. Topics include the theory and
practice of visualization, the grammar of cinematic storytelling, the aesthetics of various film
movements, camera technique, lighting, sound recording, sound design, directing, and other
fundamentals related to learning the craft and art of digital filmmaking. Students engage in critical
appreciation through individual and group analysis of movies and episodic television, as well as in
filming cinematic exercises under the supervision of their instructor.

New Course

o Credit

e Mass Communication

No value

No value
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Course Development

Basic Skill Status (CB08)

Course is not a basic skills course.

Allow Students to Gain Credit by
Exam/Challenge

https://glendale.elumenapp.com/elumen/WorkflowReport?actionMet...

Course Special Class Status (CB13)

Course is not a special class.

Pre-Collegiate Level (CB21)

Not applicable.

Transferability & Gen. Ed. Options

General Education Status (CB25)

Not Applicable

Transferability

Transferable to both UC and CSU

Units and Hours

Summary

Minimum Credit Units (CB07)
Maximum Credit Units (CB06)

Total Course In-Class (Contact)
Hours

Total Course Out-of-Class
Hours

Total Student Learning Hours

Transferability Status

Approved

2

2

72

36

108

Credit / Non-Credit Options

Course Type (CB04)

Credit - Degree Applicable

Course Classification Code (CB11)

Credit Course.

Variable Credit Course

Weekly Student Hours

In Class
Lecture Hours 1
Laboratory Hours 3
Studio Hours 0

Noncredit Course Category (CB22)

Credit Course.

Funding Agency Category (CB23)

Not Applicable.

Grading Basis
e Grade with Pass / No-Pass Option
Course Support Course Status (CB26)

Course is not a support course

Noncredit Special Characteristics

No Value

Cooperative Work Experience Education
Status (CB10)

Course Student Hours

Out of Class Course Duration (Weeks) 18
2 Hours per unit divisor 54
0 Course In-Class (Contact) Hours

0 Lecture 18
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Laboratory
Studio

Total

Course Out-of-Class Hours
Lecture

Laboratory

Studio

Total

54

72

36

36

Time Commitment Notes for Students

No value
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Pre-requisites, Co-requisites, Anti-requisites and Advisories

No Value

Entry Standards

Entry Standards

No value

Specifications

Methods of Instruction

Methods of Instruction

Methods of Instruction

Methods of Instruction

Methods of Instruction

Collaborative Learning

Demonstrations

Discussion

Field Activities (Trips)
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Methods of Instruction Guest Speakers
Methods of Instruction Lecture
Methods of Instruction Laboratory
Methods of Instruction Multimedia
Methods of Instruction Presentations

Out of Class Assignments

« Individual essays and presentations on scene analysis of cinematic style choices to propel a story and create a
cinematic world

« Individual cinematic projects that tell a story, focusing on a specific cinematic style or technique such as composition,
lighting, production design, sound design or editing

« An individual continuity shooting and editing project

« Attend resume and cover letter workshops through career development

« Create a resume, reel (if applicable) and cover letter

Methods of Evaluation Rationale

Exam/Quiz/Test Short answers to evaluate concepts, craft or technique attained

Activity (answering journal prompt, group Create a short film. Work as a team in class under faculty supervision to shoot a short film scene.

activity)

Writing Assignment Analyze a short film in context of the cinematic tools used to shape the narrative

Presentation (group or individual) Video presentation of film and/or multimedia clips revealing cinematic tools used to create
narrative

Project/Portfolio Create short films that create a narrative using a DSLR

Report Create response paper to an assigned film focused on a film technique.

Evaluation Read and critique a peer’s project

Textbook Rationale

No Value

Textbooks

Author Title Publisher Date ISBN
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Michael Rabiger and Mick Directing, Film Techniques and Routledge 2020 9780815394310
Hubris-Cherrier Aesthetics, 6th edition
Tom Schroeppel The Bare Bones Camera Course Langara College 2018 9781621535263

for Film and Video, 3rd edition

Other Instructional Materials (i.e. OER, handouts)

No Value

Materials Fee

No value

Learning Outcomes and Objectives

Course Objectives

Demonstrate basic knowledge and comprehension of film theory and grammar.

Demonstrate the ability to apply basic cinematic techniques and tools effectively such as camera techniques, composition, editing, sound design in the
expression of cinematic storytelling.

Produce and film assigned exercises that demonstrate basic understanding of the production process, including preparation of directorial materials
shot lists and floor plans, camera work, lighting and sound.

Demonstrate basic knowledge and comprehension of the various departments, key crew members and their roles and responsibilities in the motion
picture production team.

Independently shoot and edit a short silent cinematic continuity scene.

SLOs

Demonstrate the effective use of camera techniques such as composition, movement, focus and lighting in the expression of cinematic
storytelling. Expected Outcome Performance: 70.0

Define basic cinematographic terms, concepts and aesthetic principles. Expected Outcome Performance: 70.0
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Additional SLO Information

Does this proposal include revisions that might improve student attainment of course learning outcomes?

No

Is this proposal submitted in response to learning outcomes assessment data?

No

If yes was selected in either of the above questions for learning outcomes, explain and attach evidence of discussions about learning
outcomes.

No Value

SLO Evidence

No Value

Course Content

Lecture Content

Introduction to Cinematic Vocabulary and Critical Analysis (2 hours)
« Overview of Cinematic Tools
o Story
o Performance
o Visual Design (composition, production design,
mise en scene)
o Sound Design
o Picture Editing
o Introduce Film Styles
« Introduce Cinematic Art Movements
« Historically Significant Film Techniques
« Introductory Overview of Film Theory and Criticism

Introduce Story (1 hour)
o Where Does Story Come From?
o Different Approaches to Story
« Developing an Idea into a Story
« Developing a Character
« Visual and Cinematic Storytelling
« The Short Film
o Introduce Script Format
» Promoting Representation
o Content creation in relation to social justice, race/ethnicity, gender, class, sexual orientation, and ability

Composition and Camera Operation (2 hours)

« Basics of Operating a Digital Camera
o Menu Controls
o Controlling Exposure
o Controlling Color Balance
o Basics of Camera Mounting Systems

» Exposure

« The Lens (Focal Length, Aperture, Depth of Field, Plane of Critical Focus)
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« Composition
o Motivated Framing
o Creating Tension/Telling Story in the frame
= Field of View
= Camera Angles
= Rule of Thirds
= Creating and Using Depth
= Foreground, Mid-ground, Background
o Basics of Managing Subject to Camera Movement
o Mise-en-Scene

Lighting (2 hours)
« Styles of Lighting
« Basic lllumination and Exposure
« Working with Artificial versus Natural Lighting
« Lighting positions and their Function (3-point lighting)
« Types of Light Qualified and Quantified
« Basics of Lighting Instruments
« Basics of Grip Equipment
o C-Stands
o Shaping Light with Flags, Nets and Silks
« Safety of working with Lights, Electricity and G & E
« Simple Electrical Load

Production Design (1 hour)
« Visual Design/ Producing the Frame
« Story Through Colors and Textures
o Locations
« Sets and Set Pieces
» Props
« Costumes, Hair
 Break Downs

Sound Recording and Design (2 hours)
« Theory of Sound
« Sound Aesthetics and Psychoacoustics
« Choice and Use of Microphones
« Recording Technique and Levels

« Building and Designing Three Stems of Audio (FX, Production, Music)

Working with Crew and Production Process (1 hour)
« Introduce Stages of Production

o Development, Pre-Production, Production, Post-Production, Distribution

» Tasks, Department and Crew at each stage
« Creative Producing

o Introduce responsibility and role of scheduling and budgeting in relationship to creative process

o Introduce Lining a Script

o The business of Producing.
= Role of Marketing and Distribution
= Legal

« Roles and Responsibilities of Departments and Each Crew Member

o Role and Structure of Departments Defined
o Crew Positions defined

o Introduce Previsualization Materials for Each Department

7 of 11
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» Look Books, Image Boards, Director's Notebook
= Shot Lists, Overheads, Storyboards
= Scene Breakdowns

o Communication with Crew

o Value of Collaboration

o Ethics and Safety of Crew Management

Working with Cast (1 hour)
« Basics of Directing Actors

Coverage and Continuity (2 hours)

« Basic Coverage Defined
o Continuous Editing versus Jump Cuts Defined
o Screen Direction and Index Vectors

» Motivated Coverage

» Camera Blocking

« Actor Blocking

« Application of Overheads, Shot lists and Storyboards

Post-Production and Editing (2 hours)
« Continuity in Editing
« Editing Software Familiarization
« Aesthetics of Editing
o Creating space
o Creating time
o Creating Rhythm and Tempo
o Creating Story
o Building a Performance
o Associative Editing
o Visual Design Choices
» Graphic Vectors
= Index Vectors (eyelines)
= Motion Vectors
= Eye Trace
» Screen Direction
o Sound Design
o Titles, Graphics, VFX
« Introduce Workflow and File Management
o Importing video and audio
o Project Set Up
o Exporting

Pathways Into the Industry (2 hours)
 Department Occupational Career Paths Identified
« Career and jobs data
o State websites/resources introduced
« Steps and pathways to attaining employment opportunities in different departments reviewed
» Resume Building
« Creating a Reel
« Cover Letter Writing
« Interviewing
» Networking in the industry

Total: 18 Hours
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Laboratory/Studio Content

Introduction to Cinematic Vocabulary and Critical Analysis (2 hours)
« Overview of Cinematic Tools
o Story
o Performance
o Visual Design (composition, production design,
mise en scene)
o Sound Design
o Picture Editing
o Introduce Film Styles
o Introduce Cinematic Art Movements
« Historically Significant Film Techniques
« Introductory Overview of Film Theory and Criticism

Introduce Story (2 hours)
o Where Does Story Come From?
o Different Approaches to Story
« Developing an Idea into a Story
« Developing a Character
« Visual and Cinematic Storytelling
« The Short Film
o Introduce Script Format
» Promoting Representation
o Content creation in relation to social justice, race/ethnicity, gender, class, sexual orientation, and ability

Composition and Camera Operation (8 hours)
« Basics of Operating a Digital Camera
o Menu Controls
o Controlling Exposure
o Controlling Color Balance
o Basics of Camera Mounting Systems
» Exposure
« The Lens (Focal Length, Aperture, Depth of Field, Plane of Critical Focus)
« Composition
o Motivated Framing
o Creating Tension/Telling Story in the frame
= Field of View
» Camera Angles
= Rule of Thirds
» Creating and Using Depth
= Foreground, Mid-ground, Background
o Basics of Managing Subject to Camera Movement
o Mise-en-Scene

Lighting (4 hours)
« Styles of Lighting
« Basic lllumination and Exposure
» Working with Artificial versus Natural Lighting
» Lighting positions and their Function (3-point lighting)
« Types of Light Qualified and Quantified
« Basics of Lighting Instruments
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« Basics of Grip Equipment

o C-Stands

o Shaping Light with Flags, Nets and Silks
« Safety of working with Lights, Electricity and G & E
« Simple Electrical Load

Production Design (2 hours)
« Visual Design/ Producing the Frame
« Story Through Colors and Textures
« Locations
« Sets and Set Pieces
» Props
» Costumes, Hair
« Break Downs

Sound Recording and Design (4 hours)
« Theory of Sound
« Sound Aesthetics and Psychoacoustics
« Choice and Use of Microphones
« Recording Technique and Levels
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« Building and Designing Three Stems of Audio (FX, Production, Music)

Working with Crew and Production Process (5 hours)
« Introduce Stages of Production

o Development, Pre-Production, Production, Post-Production, Distribution

= Tasks, Department and Crew at each stage

« Creative Producing

o Introduce responsibility and role of scheduling and budgeting in relationship to creative process

o Introduce Lining a Script

o The business of Producing.
» Role of Marketing and Distribution
» Legal

« Roles and Responsibilities of Departments and Each Crew Member

o Role and Structure of Departments Defined
o Crew Positions defined

o Introduce Previsualization Materials for Each Department
» Look Books, Image Boards, Director's Notebook

= Shot Lists, Overheads, Storyboards
= Scene Breakdowns

o Communication with Crew

o Value of Collaboration

o Ethics and Safety of Crew Management

Working with Cast (1 hour)
« Basics of Directing Actors

Coverage and Continuity (8 hours)

« Basic Coverage Defined
o Continuous Editing versus Jump Cuts Defined
o Screen Direction and Index Vectors

» Motivated Coverage

» Camera Blocking

« Actor Blocking

« Application of Overheads, Shot lists and Storyboards

Post-Production and Editing (10 hours)
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« Continuity in Editing
« Editing Software Familiarization
« Aesthetics of Editing
o Creating space
o Creating time
o Creating Rhythm and Tempo
o Creating Story
o Building a Performance
o Associative Editing
o Visual Design Choices
» Graphic Vectors
» Index Vectors (eyelines)
» Motion Vectors
= Eye Trace
= Screen Direction
o Sound Design
o Titles, Graphics, VFX
o Introduce Workflow and File Management
o Importing video and audio
o Project Set Up
o Exporting

Pathways Into the Industry (8 hours)
 Department Occupational Career Paths Identified
o Career and jobs data
o State websites/resources introduced
« Steps and pathways to attaining employment opportunities in different departments reviewed
» Resume Building
« Creating a Reel
« Cover Letter Writing
« Interviewing
 Networking in the industry

Total: 54 Hours
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